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English 

Operation Guide for Holter Recorder   
and AI-ECG Analysis System 

1. Operation Flow 
 

 

 
 

 
 
 
 
 

2. Operation Instructions 
1) Prepare for ECG recording 

1. Install new batteries and ensure its positive and negative poles are 
correct. After the battery is correctly installed, the recorder will start 
up automatically and the screen will display the startup interface. 

 Caution 

 DO NOT insert a battery with the positive and negative poles 
reversed. 

 If the device prompts "Insufficient voltage!!! Do you want to 
continue?", you can select "Yes" to continue or replace with 
new batteries. However, if you select "Yes", Holter Recorder 
may not be able to record the data for 24 hours. 

 If the device prompts "Please replace with new batteries!", 
please remove the screws from the battery cover and replace 
with AAA/1.5V alkaline batteries. 

Prepare for ECG recording 

Record ECG 

Install and update software 

Export and analyze data 
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2. Connect the lead wire to ECG recorder. 

 Caution 

If you need to use the device for a long time, please keep the lead 
wire connected to the device and do not plug and unplug the lead 
wire repeatedly! 

3. Electrodes Placement: 

 Fasten the disposable electrodes into the electrode joint of lead 
wire.  

 Remove the protective packaging on the back of the disposable 
electrodes.  

 Place the electrodes correctly in accordance with the electrode 
placement illustration, and ensure the electrodes are firmly 
pasted on the user's skin. 

 

 

 

 
 

 

 

 

 

 

 
 

 

 

 

 

 

 

4th intercostal space 
(Approximately aligned with 

the nipple) 5th intercostal 
space 

Level of the navel  

Right midclavicular line Left midclavicular line 

Right sternal midline Left sternal midline 

4th intercostal  
space 

5th intercostal 
space 

Level of the navel  

Right midclavicular line Left midclavicular line 
 

Right sternal 
midline 

Left sternal  
midline 

Midaxillary 
line 

Anterior  
axillary line 
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 AHA 
Color 

AHA 
Label Position 

1 Red V1 The fourth intercostal space at the right edge of 
sternum 

2 Yellow V2 The fourth intercostal space at the left edge of 
sternum 

3 Green V3 The position between V2 and V4 

4 Blue V4 Midclavicular line at the fifth intercostal space 

5 Orange V5 Anterior axillary line at the same level as V4 

6 Purple V6 Midaxillary line at the same level as V4 and V5 

7 Black LA Left shoulder 

8 Red LL The lower edge of rib cage, or the level of the navel 
at the position of middle clavicle line. 

9 Green RL The lower edge of rib cage, or the level of the navel 
at the position of middle clavicle line. 

10 White RA Right shoulder 

2) Record ECG 

1. Press the Enter button to wake up the screen. 

2. Select "MENU" -- "Date & Time" and set the device to the current date 
and time. 

3. Select "ESC" to return to the menu interface. Select "Options" -- "Gain" 
to set the appropriate recording gain. 

4. Select "ESC" to return to the menu interface and select "ECG review" 
(Note: the device has not yet started recording ECG). 

5. Press the Enter button to access the recording operation interface. 
Select "OK" to start ECG monitoring and recording. 
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6. Confirm the user ID. If the ID number needs to be modified, please 
modify it on this interface. 

7. Please wait for the system to complete the SD card formatting 
automatically. After formatting, the system will automatically access 
the recording interface. 

8. Put the Holter Recorder into a leather case and wear it with the belt 
or shoulder strap. 

9. Recording will stop automatically after 24 hours. 

10. After the recording ends, please take off the recorder according to 
the following steps: 

 Remove the waste battery and dispose it appropriately in 
accordance with the local law. 

 Press the SD card and it will automatically pop up. Then, hook 
the groove with your fingernail to remove the SD card. 

 
 Remove the electrodes from the user and separate the lead 

wires from the electrodes. 

 Note 

 Transfer ECG data in the SD card to the AI-ECG Analysis System, 
because Holter Recorder will automatically format the SD card every 
time the ECG recording is started. 

 Ensure that the SD card is unlocked. 
 In the waveform interface, if no button is pressed for 15 seconds, the 

system will automatically switch to standby mode. Press the Enter 
button, the system screen will display again. 
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Name Button Function 

Up button  

 Switch to the previous lead. 
 Reduce the setting value. 
 Move the cursor up/left. 

Down button  

 Switch to the next lead. 
 Increase the setting value. 
 Move the cursor down/right. 

Enter button 
 

 Enter the setting value. 
 Enable the "Recording Operation" 

page. 
 Mark the events during recording. 

Down button + 
Enter button  +  

 Enable the "Exit Recording" page. 

3) Install and update software 

1. Choose one of the following methods to download the AI-ECG 
analysis system. 

 Visit the website https://getwellue.com/pages/pc-software to 
download the latest version of AI-ECG Analysis System (for 
Windows / Mac OS users). 

 Download the installation file from the USB drive (for Windows 
users only). 

2. Run the installation file and select the defaults until finish 
installation. 

3. If you need to update the AI-ECG analysis system, click "Settings" in 
the upper right corner of the main interface of the analysis system. 
When the "!" mark appears on the "Check for Updates", please 
manually update to the latest version. 
 
 
 
 
 
 

https://getwellue.com/pages/pc-software
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 Note 

 

 If a similar interface pops up, 
please click "Close". 

 

 If a similar interface pops up, 
please click "Install". 

4) Export and analyze data 

1. Run the AI-ECG Analysis System. 

2. Insert the SD into the card reader, and insert the card reader into the 
computer. 

 
3. When the device serial number appears in the lower left corner of the 

software, the connection is successful. Click the "Download Data" 
button. Create or select a user. Then the data will automatically be 
imported to the analysis system and shown in the task list. 
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4. Click "View ECG" to view and download the complete ECG waveform. 
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5. Click "Analyze" and register. This recording will be uploaded to the 
server and an ECG report will be generated.  

 Note 

If the login interface pops up, please click "Go to login" and 
complete the registration. 

If you need to register, please: 
 Get the verification code from your email within 15 minutes 

and complete the registration. 
 After 15 minutes, you need to get the verification code again. 

6. After the analysis is complete, click "View Report" to view and 
download the ECG report. 
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Españo 

Guía de funcionamiento para el 
registrador Holter                      

y el sistema de análisis AI-ECG 

1. Flujo operativo 

 
 

 
 
 
 
 
 
 

2. Instrucciones de funcionamiento 

1) Preparación para el registro del ECG 

1. Instale baterías nuevas y asegúrese de que los polos positivo y 
negativo estén en la posición correcta. Una vez instalada 
correctamente la batería, el registrador se iniciará automáticamente 
y en la pantalla se mostrará la interfaz de inicio. 

 Precaución 

 NO introduzca ninguna batería con los polos positivo y 
negativo invertidos. 

 Si el sistema muestra el mensaje «Insufficient voltage!!! Do 
you want to continue» (Voltaje insuficiente. ¿Quiere continuar?), 
puede seleccionar «Yes» (Sí) para continuar o sustituir las 
baterías por otras nuevas. No obstante, si selecciona «Yes» (Sí), 

Preparación para el registro del ECG 

Registro del ECG 

Instalación y actualización del software 

Exportación y análisis de datos 
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es posible que el registrador Holter no pueda registrar datos 
durante 24 horas. 

 Si el dispositivo muestra el mensaje «Please replace with new 
batteries!» (Sustituya las baterías por otras nuevas.), retire los 
tornillos de la cubierta de la batería y sustitúyalas por 
baterías alcalinas AAA de 1,5V. 

2. Conecte el cable conductor al registrador del ECG. 

 Precaución 

Si necesita utilizar el dispositivo durante un período prolongado, 
mantenga el cable conductor conectado al dispositivo y no 
enchufe ni desenchufe el cable conductor de manera repetida. 

3. Colocación de los electrodos: 
 Sujete los electrodos desechables en la junta de electrodos del 

cable conductor.  

 Retire el envoltorio protector de la parte posterior de los 
electrodos desechables.  

 Coloque los electrodos correctamente de acuerdo con la 
ilustración de colocación de los electrodos y asegúrese de que 
estén enganchados firmemente a la piel del usuario. 

 

 
 

 

 

 

 

 

 
 

 

 

 

4.º espacio intercostal 
(aproximadamente alineado 

con el pezón) 5.º espacio 
intercostal 

Nivel del ombligo  

Línea medioclavicular 
derecha 

Línea medioclavicular 
izquierda 

Línea medioesternal derecha Línea medioesternal 
izquierda 4.º espacio  

intercostal 

5.º espacio 
intercostal 

Nivel del ombligo  

Línea medioclavicular 
derecha 

Línea medioclavicular 
izquierda 
 

Línea 
medioesternal 

derecha 
Línea medioesternal  
izquierda 

Línea 
medioaxilar 

Línea  
axilar anterior 
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 AHA 
Color 

AHA 
Etiqueta Posición 

1 Rojo V1 El cuarto espacio intercostal en el extremo derecho 
del esternón 

2 Amarillo V2 El cuarto espacio intercostal en el extremo izquierdo 
del esternón 

3 Verde V3 La posición entre V2 y V4 

4 Azul V4 Línea medioclavicular en el quinto espacio 
intercostal 

5 Naranja V5 Línea axilar anterior al mismo nivel que V4 

6 Morado V6 Línea medioaxilar al mismo nivel que V4 y V5 

7 Negro LA Hombro izquierdo 

8 Rojo LL El extremo inferior de la caja torácica o el nivel del 
ombligo en la posición de la línea medioclavicular 

9 Verde RL El extremo inferior de la caja torácica o el nivel del 
ombligo en la posición de la línea medioclavicular 

10 Blanco RA Hombro derecho 

2) Registro del ECG 

1. Pulse el botón Entrar para activar la pantalla. 

2. Seleccione «MENU» (MENÚ) -- «Date & Time» (Fecha y hora) y 
establezca en el dispositivo la fecha y la hora actuales. 

3. Seleccione «ESC» para volver a la interfaz del menú. Seleccione 
«Options» (Opciones) -- «Gain» (Ganancia) para establecer la 
ganancia de registro apropiada. 

4. Seleccione «ESC» para volver a la interfaz del menú y seleccione 
«ECG review» (Revisión del ECG) (Nota: El dispositivo todavía no ha 
comenzada a registrar el ECG). 

5. Pulse el botón Entrar para acceder a la interfaz operativa de registro. 
Seleccione «OK» (Aceptar) para comenzar a monitorizar y registrar el 
ECG. 
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6. Confirme el identificador del usuario. Si se debe modificar el número 
del identificador, hágalo en esta interfaz. 

7. Espere a que el sistema acabe de formatear automáticamente la 
tarjeta SD. Después del formateo, el sistema accederá de manera 
automática a la interfaz de registro. 

8. Coloque el registrador Holter en una caja de cuero y llévelo en el 
cinturón o en una correa de hombro. 

9. El registro se detendrá automáticamente al cabo de 24 horas. 

10. Una vez finalizado el registro: extraiga el registrador según los pasos 
siguientes: 

 Retire la batería y elimínela adecuadamente de acuerdo con la 
legislación local. 

 Presione la tarjeta SD y se expulsará automáticamente. A 
continuación, enganche el surco con la uña para extraer la 
tarjeta SD. 

 
 Retire los electrodos del usuario y separe los cables 

conductores de los electrodos. 

 Nota 

 Transfiera los datos del ECG de la tarjeta SD al sistema de análisis 
AI-ECG, ya que el registrador Holter formateará automáticamente la 
tarjeta SD cada vez que se inicie el registro del ECG. 

 Asegúrese de que la tarjeta SD esté desbloqueada. 
 En la interfaz de onda, si no se pulsa ningún botón a lo largo de 

15 segundos, el sistema cambiará automáticamente al modo de 
espera. Al pulsar el botón Entrar, la pantalla del sistema se volverá 
a mostrar. 
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Nombre Botón Función 

Botón Arriba  

 Cambia al cable anterior. 
 Reduce el valor del parámetro. 
 Mueve el cursor hacia arriba o hacia la 

izquierda. 

Botón Abajo  

 Cambia al cable siguiente. 
 Aumenta el valor del parámetro. 
 Mueve el cursor hacia abajo o hacia la 

derecha. 

Botón Entrar 
 

 Introduce el valor del parámetro. 
 Activa la página «Recording 

Operation» (Operación de registro). 
 Marca los eventos durante el registro. 

Botón Abajo + 
botón Entrar  +  

 Activa la página «Exit Recording» 
(Salir del registro). 

3) Instalación y actualización del software 

1. Elija uno de los métodos siguientes para descargar el sistema de 
análisis AI-ECG. 
 Visite el sitio web https://getwellue.com/pages/pc-software 

para descargar la versión más reciente del sistema de análisis 
AI-ECG (para usuarios de Windows y Mac OS). 

 Descargue el archivo de instalación de la unidad USB (solo 
para usuarios de Windows). 

2. Ejecute el archivo de instalación y seleccione las opciones 
predeterminadas hasta finalizar la instalación. 

3. Si necesita actualizar el sistema de análisis AI-ECG, haga clic en 
«Settings» (Configuración) en el extremo superior derecho de la 
interfaz principal del sistema de análisis. Cuando se muestre la 
marca «!» en «Check for Updates» (Buscar actualizaciones), actualice 
manualmente a la versión más reciente. 

 

 

https://getwellue.com/pages/pc-software
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 Nota 

 

 Si se muestra una interfaz similar 
en una ventana emergente, haga 
clic en «Close» (Cerrar). 

 

 Si se muestra una interfaz similar 
en una ventana emergente, haga 
clic en «Instalar» (Install). 

4) Exportación y análisis de datos 

1. Ejecute el sistema de análisis AI-ECG. 

2. Introduzca la tarjeta SD en el lector de tarjetas y este en el 
ordenador. 

 
3. Cuando el número de serie del dispositivo se muestre en el extremo 

inferior izquierdo del software, la conexión se habrá establecido 
correctamente. Haga clic en el botón «Download Data» (Descargar 
datos). Cree o seleccione a un usuario. A continuación, los datos se 
importarán automáticamente al sistema de análisis y se mostrarán 
en la lista de tareas. 
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4. Haga clic en «View ECG» (Vista ECG) para visualizar y descargar la 

onda completa del ECG. 
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5. Haga clic en «Analyze» (Analizar) y registre. Este registro se cargará 
en el servidor y se generará un informe del ECG.  

 Nota 

Si la interfaz de inicio de sesión se muestra en una ventana 
emergente, haga clic en «Go to login» (Ir a inicio de sesión) y 
complete el registro. 

Si necesita registrar: 
 Obtenga el código de verificación de su correo electrónico en 

15 minutos y complete el registro. 
 Pasados15 minutos, tendrá que volver a obtener el código de 

verificación. 
6. Una vez completado el análisis, haga clic en «View Report» (Vista del 

informe) para visualizar y descargar el informe del ECG. 
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Français 

Guide d’opération de l’enregistreur Holter 
et du système d’analyse AI-ECG 

1. Déroulement des opérations 

 
 

 
 
 
 
 
 
 

2. Mode d’emploi 
1) Préparation pour l’enregistrement de l’ECG 

1. Installez des piles neuves et vérifiez l’emplacement correct des 
bornes positives et négatives. Après avoir installé les piles 
correctement, l’enregistreur démarre automatiquement et l’écran 
affiche l’interface de démarrage. 

 Attention 

 N’insérez PAS une pile dont les pôles positif et négatif sont 
inversés. 

 Si l’appareil vous indique « Insufficient voltage!!! Do you want 
to continue? » (Tension insuffisante ! Voulez-vous continuer ?), 
vous pouvez sélectionner « Yes » (Oui) pour continuer ou 
remplacer les piles par des neuves. Toutefois, si vous 
sélectionnez « Yes » (Oui), il se peut que l’enregistreur Holter 

Préparation de l’enregistrement de l’ECG 

Enregistrement de l’ECG 

Installation et mise à jour du logiciel 

Exportation et analyse des données 



18 

ne soit pas en mesure d’enregistrer les données pendant 
24 heures. 

 Si l’appareil vous indique «Please replace with new batteries!» 
(Veuillez remplacer par des piles neuves!), retirez les vis du 
couvercle des piles et remplacez par des piles alcalines 
AAA/1,5V. 

2. Connectez le fil de dérivation à l’enregistreur ECG. 

 Attention 

Si vous devez utiliser l’appareil pendant une longue période, 
veuillez garder le fil conducteur connecté à l’appareil et éviter de 
brancher et débrancher le fil conducteur à plusieurs reprises! 

3. Positionnement des électrodes: 

 Fixez les électrodes jetables dans le joint d’électrode du fil 
conducteur.  

 Retirez l’emballage de protection au dos des électrodes jetables.  

 Placez les électrodes correctement conformément à l’illustration 
de positionnement des électrodes, et assurez-vous que les 
électrodes sont fermement collées sur la peau de l’utilisateur. 
 

 

 

 

 

 

 
 

 

 

 

 

 

 
 

4ème espace intercostal 
(approximativement aligné 

avec le mamelon) 5ème espace 
intercostal 

Niveau du nombril  

Ligne 
médio-claviculaire 

droite 

Ligne 
médio-claviculaire 

gauche 

Ligne médiane sternale droite Ligne médiane sternale 
gauche 4ème espace  

intercostal 

5ème espace 
intercostal 

Niveau du nombril  

Ligne médio-claviculaire 
droite 

Ligne médio-claviculaire 
gauche 
 

Ligne médiane 
sternale droite 

Ligne médiane sternale  
gauche 

Ligne 
médioaxillaire 

Ligne  
axillaire antérieure 
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 Couleur 
AHA 

Label 
AHA Emplacement 

1 Rouge V1 Quatrième espace intercostal au niveau du bord droit 
du sternum 

2 Jaune V2 Quatrième espace intercostal au niveau du bord 
gauche du sternum 

3 Vert V3 La position entre V2 et V4 

4 Bleu V4 Ligne médio-claviculaire au niveau du cinquième 
espace intercostal 

5 Orange V5 Ligne axillaire antérieure au même niveau que V4 

6 Violet V6 Ligne médio-axillaire au même niveau que V4 et V5 

7 Noir BG Épaule gauche 

8 Rouge JG 
Le bord inférieur de la cage thoracique, ou le niveau 
du nombril à la position de la ligne 
médio-claviculaire 

9 Vert JD 
Le bord inférieur de la cage thoracique, ou le niveau 
du nombril à la position de la ligne 
médio-claviculaire 

10 Blanc BD Épaule droite 

2) Enregistrement de l’ECG 

1. Appuyez sur le bouton Entrée pour réveiller l’écran 

2. Sélectionnez « MENU » (MENU) -- « Date & Time » (Date et heure) et 
réglez l’appareil sur la date et l’heure actuelles. 

3. Sélectionnez « ESC » (ÉCHAP) pour revenir à l’interface du menu. 
Sélectionnez « Options » (Options) -- « Gain » (Gain) pour régler le 
gain d’enregistrement approprié. 

4. Sélectionnez « ESC » (ÉCHAP) pour revenir à l’interface du menu et 
sélectionnez « ECG review » (Examen ECG) (Remarque : l’appareil n’a 
pas encore commencé à enregistrer l’ECG). 

5. Appuyez sur le bouton Entrée pour accéder à l’interface 
d’enregistrement. Sélectionnez « OK » (OK) pour lancer la 
surveillance et l’enregistrement de l’ECG. 
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6. Vérifiez l’ID utilisateur. Si le numéro d’identification doit être modifié, 

veuillez le faire sur cette interface. 

7. Attendez que le système termine le formatage automatique de la 
carte SD. Après le formatage, le système accède automatiquement à 
l’interface d’enregistrement. 

8. Placez l’Enregistreur Holter dans sa pochette en cuir et portez-le avec 
la ceinture ou la bandoulière. 

9. L’enregistrement s’arrête automatiquement au bout de 24 heures 

10. Une fois l’enregistrement terminé, veuillez retirer l’enregistreur en 
procédant comme suit : 

 Retirez la batterie usagée et jetez-la conformément à la 
législation locale. 

 appuyez sur la carte SD et elle s’éjecte automatiquement. 
Ensuite, crochetez la rainure avec votre ongle pour retirer la 
carte SD. 

 
 Retirez les électrodes de l’utilisateur et séparez les fils 

conducteurs des électrodes. 

 Remarque 

 Transférez les données ECG de la carte SD vers le système 
d’analyse AI-ECG, car l’enregistreur Holter formate 
automatiquement la carte SD chaque fois que l’enregistrement de 
l’ECG est lancé. 

 Assurez-vous que la carte SD est déverrouillée. 
 Dans l’interface de forme d’onde, si vous n’appuyez sur aucun 

bouton pendant 15 secondes, le système passe automatiquement 
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en mode veille. Appuyez sur le bouton Entrée pour que l’écran du 
système s’affiche à nouveau. 

Nom Bouton Fonction 

Bouton Haut  

 Permet de retourner à la 
dérivation précédente. 

 Permet de réduire la valeur de 
réglage. 

 Permet de déplacer le curseur 
vers le haut/à gauche. 

Bouton Bas  

 Permet de passer à la dérivation 
suivante. 

 Permet d’augmenter la valeur de 
réglage. 

 Permet de déplacer le curseur 
vers le bas/à droite. 

Bouton Entrée 
 

 Permet de saisir la valeur de 
réglage. 

 Permet d’activer la page 
« Recording Operation » (Fonction 
d’enregistrement). 

 Permet de marquer les 
événements pendant 
l’enregistrement. 

Bouton Bas + 
Bouton Entrée  +  

 Permet d’activer la page « Exit 
Recording » (Quitter 
l’enregistrement). 
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3) Installation et mise à jour du logiciel 

1. Choisissez l’une des méthodes suivantes pour télécharger le système 
d’analyse AI-ECG. 

 Visitez le site web https://getwellue.com/pages/pc-software 
pour télécharger la dernière version du système d’analyse 
AI-ECG (pour les utilisateurs de Windows / Mac OS). 

 Téléchargez le fichier d’installation à partir de la clé USB (pour 
les utilisateurs de Windows uniquement). 

2. Exécutez le fichier d’installation et sélectionnez les valeurs par défaut 
jusqu’à la fin de l’installation. 

3. Si vous devez mettre à jour le système d’analyse AI-ECG, cliquez sur 
« Settings » (Réglages) dans le coin supérieur droit de l’interface 
principale du système d’analyse. Lorsque la marque « ! » apparaît 
dans la fenêtre « Check for Updates » (Vérifier les mises à jour), 
veuillez mettre à jour manuellement vers la dernière version. 

 Remarque 

 

 Si une interface similaire 
s’affiche, veuillez cliquer sur 
« Close » (Fermer). 

 

 Si une interface similaire 
s’affiche, veuillez cliquer sur 
« Install » (Installer). 

  

https://getwellue.com/pages/pc-software
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4) Exportation et analyse des données 

1. Exécutez le système d’analyse AI-ECG. 

2. Insérez la carte SD dans le lecteur de cartes, puis insérez le lecteur de 
cartes dans l’ordinateur. 

 
3. Lorsque le numéro de série de l’appareil apparaît dans le coin 

inférieur gauche du logiciel, la connexion est réussie. Cliquez sur le 
bouton « Download Data » (Télécharger les données). Créez ou 
sélectionnez un utilisateur. Les données seront alors 
automatiquement importées dans le système d’analyse et affichées 
dans la liste des tâches. 

 

4. Cliquez sur « View ECG » (Afficher ECG) pour afficher et télécharger la 
forme d’onde complète de l’ECG. 
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5. Cliquez sur « Analyze » (Analyser) et enregistrez. L’enregistrement 
sera téléchargé sur le serveur et un rapport ECG sera créé.  

 Remarque 

Si l’interface de connexion s’affiche, veuillez cliquer sur « Go to 
login » (Aller à la page de connexion) et terminer l’enregistrement. 

Si vous devez vous enregistrer :  
 Obtenez le code de vérification de votre e-mail dans les 

15 minutes et terminez l’enregistrement. 
 Après 15 minutes, vous devez obtenir à nouveau le code de 

vérification. 
6. Une fois l’analyse terminée, cliquez sur « View Report » (Afficher le 

rapport) pour afficher et télécharger le rapport ECG. 
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Deutsch 

Bedienerhandbuch für Holter-Schreiber 
und AI-EKG Analysesystem 

1. Bedienungsablauf 
 

 

 

 

 

 

 

2. Bedienungsanleitung 
1) EKG-Aufzeichnung vorbereiten 

1. Legen Sie neue Batterien ein und achten Sie darauf, dass die Plus- 
und Minuspole richtig gepolt sind. Nach dem korrekten Einsetzen der 
Batterie startet der Schreiber automatisch, und auf dem Bildschirm 
wird die Startoberfläche angezeigt. 

 Achtung 

 Legen Sie eine Batterie NICHT mit vertauschten Plus- und 
Minuspolen ein. 

 Wenn das Gerät die Meldung „Insufficient voltage!!! Do you want 
to continue?“ (Unzureichende Spannung!!! Möchten Sie 
fortfahren?) ausgibt, können Sie „Yes“ (Ja) wählen, um 
fortzufahren oder die Batterien durch neue zu ersetzen. Wenn Sie 
jedoch „Yes“ (Ja) wählen, kann der Holter-Schreiber die Daten 
möglicherweise 24 Stunden lang nicht aufzeichnen. 

EKG-Aufzeichnung vorbereiten 

EKG aufzeichnen 

Die Software installieren und aktualisieren 

Exportieren und Analysieren von Daten 
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 Wenn das Gerät die Aufforderung „Please replace with new 
batteries!“ (Bitte ersetzen Sie die Batterien!) ausgibt, bitte 
entfernen Sie die Schrauben der Batteriefachabdeckung und 
ersetzen Sie diese durch AAA/1,5V Alkalibatterien. 

2. Schließen Sie das Elektrodenkabel an den EKG-Schreiber an. 

 Achtung 

 Wenn Sie das Gerät über einen längeren Zeitraum verwenden 
möchten, lassen Sie bitte das Elektrodenkabel am Gerät 
angeschlossen und stecken Sie das Elektrodenkabel nicht 
wiederholt ein und aus! 

3. Platzierung der Elektroden 

 Befestigen Sie die Einwegelektroden an der 
Elektrodenverbindung des Elektrodenkabels.  

 Entfernen Sie die Schutzverpackung auf der Rückseite der 
Einwegelektroden.  

 Platzieren Sie die Elektroden entsprechend der Abbildung zur 
Elektrodenplatzierung, und achten Sie darauf, dass die 
Elektroden fest auf der Haut des Benutzers sitzen. 

 
 

 

 

Der vierte Zwischenrippenraum 
(ungefähr auf einer Linie mit 

der Brustwarze) 
Der fünfte 
Zwischenrippenraum 

Die Höhe des Bauchnabels 

Die rechte  
Medioklavikularlinie 

Die linke  
Medioklavikularlinie 
 

Die rechte  
Brustbeinmittellinie 

Die linke 
Brustbeinmittellinie 

Der vierte  
Zwischenrippenraum 

Der fünfte  
intercostal space 

Die Höhe des Bauchnabels  

Die rechte 
Medioklavikularlinie 

 

Die linke 
Medioklavikularlinie 

Die rechte 
Brustbeinmittellinie 

Die linke 
Brustbeinmittellinie 
 

Die mittlere 
Axillarlinie 

Die vordere 
Axillarlinie 
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 AHA 
Farbe 

AHA 
Etikett Position 

1 Rot V1 Der vierte Zwischenrippenraum am rechten Rand 
des Brustbeins 

2 Gelb V2 Der vierte Zwischenrippenraum am linken Rand 
des Brustbeins 

3 Grün V3 Die Position zwischen V2 und V4 

4 Blau V4 Medioklavikularlinieam im fünften 
Zwischenrippenraum 

5 Orange V5 Vordere Axillarlinie auf der Höhe von V4 

6 Violett V6 Mittlere Axillarlinie auf der Höhe von V4 und V5 

7 Schwarz LA Linke Schulter 

8 Rot LL Die Unterkante des Brustkorbs oder die Höhe des 
Nabels an der Position der Medioklavikularlinie 

9 Grün RL Die Unterkante des Brustkorbs oder die Höhe des 
Nabels an der Position der Medioklavikularlinie 

10 Weiß RA Rechte Schulter 

2) EKG aufzeichnen 

1. Drücken Sie die Eingabe-Taste, um den Bildschirm aufzuwecken. 

2. Wählen Sie „MENU“ (MENÜ)-- „Date & Time“ (Datum & Uhrzeit) und 
stellen Sie das Gerät auf das aktuelle Datum und die Uhrzeit ein. 

3. Wählen Sie „ESC“ (BEENDEN), um zur Menüoberfläche 
zurückzukehren. Wählen Sie „Options“ (Optionen)-- 
„Gain“ (Verstärkung), um die geeignete Aufnahmeverstärkung 
einzustellen. 

4. Wählen Sie „ESC“ (BEENDEN), um zur Menüoberfläche zurückzukehren, 
und wählen Sie „ECG review“ (EKG-Überprüfung) (Hinweis: Das Gerät 
hat noch nicht mit der EKG-Aufzeichnung begonnen). 

5. Drücken Sie die Eingabe-Taste, um auf die Aufzeichnungsoberfläche 
zuzugreifen. Wählen Sie „OK“, um die EKG-Überwachung und 
-Aufzeichnung zu starten. 
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6. Bestätigen Sie die Personen-ID. Wenn die ID-Nummer geändert 

werden muss, ändern Sie sie bitte auf dieser Schnittstelle. 

7. Bitte warten Sie, bis das System die Formatierung der SD-Karte 
automatisch abgeschlossen hat. Nach der Formatierung greift das 
System automatisch auf die Aufzeichnungsoberfläche zu. 

8. Setzen Sie den Holter-Schreiber in eine Ledertasche und tragen Sie 
ihn mit dem Gürtel oder Schultergurt. 

9. Die Aufzeichnung wird nach 24 Stunden automatisch beendet. 

10. Nach dem Ende der Aufnahme nehmen Sie den Schreiber bitte wie 
folgt ab: 

 Entfernen Sie die Altbatterie und entsorgen Sie sie entsprechend 
der örtlichen Gesetzgebung. 

 Drücken Sie auf die SD-Karte, und sie wird automatisch 
eingeblendet. Pressen Sie dann den Fingernagel in die Rille, um 
die SD-Karte zu entfernen. 

 
 Entfernen Sie die Elektroden von der Person und trennen Sie die 

Elektrodenkabel von den Elektroden. 

 Hinweis 

 Übertragen Sie die EKG-Daten auf der SD-Karte an das AI-EKG 
Analysesystem, da der Holter-Aufzeichner die SD-Karte bei jedem 
Start der EKG-Aufzeichnung automatisch formatiert. 

 Bitte vergewissern Sie sich, dass die SD-Kartensperre eingeschaltet 
ist. 
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 Wenn auf der Wellenform-Oberfläche 15 Sekunden lang keine  

Taste gedrückt wird, schaltet das System automatisch in den 
Standby-Modus. Drücken Sie die Eingabe-Taste, der 
Systembildschirm wird wieder angezeigt. 

Name Taste Funktion 

Aufwärts-Taste  

 Wechselt zur vorherigen Elektrode. 
 Verringert den Einstellwert. 
 Bewegt den Cursor nach 

oben/links. 

Abwärts-Taste  

 Wechseln Sie zur nächsten 
Elektrode. 

 Erhöht den Einstellwert. 
 Bewegt den Cursor nach 

unten/rechts. 

Eingabe-Taste 
 

 Gibt den Einstellwert ein. 
 Aktiviert die Seite „Recording 

Operation“ (Aufzeichnungsbetrieb). 
 Markiert die Ereignisse während der 

Aufzeichnung. 

Abwärts-Taste + 
Eingabe-Taste  +  

 Aktiviert die Seite „Exit 
Recording“ (Aufzeichnung 
beenden) 

3) Die Software installieren und aktualisieren 

1. Wählen Sie eine der folgenden Verfahren, um das 
AI-EKG-Analysesystem herunterzuladen. 

 Besuchen Sie die Website 
https://getwellue.com/pages/pc-software, um die neueste 
Version des AI-EKG-Analysesystems herunterzuladen (für 
Windows-/Mac OS-Benutzer). 

 Laden Sie die Installationsdatei von einem USB-Laufwerk 
herunter (nur für Windows-Benutzer). 
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2. Führen Sie die Installationsdatei aus und wählen Sie die 
Standardeinstellungen aus, bis die Installation abgeschlossen ist. 

3. Wenn Sie das AI-EKG-Analysesystem aktualisieren müssen, klicken 
Sie auf „Einstellungen“ rechts oben in der Bedieneroberfläche des 
Analysesystems. Wenn die Markierung „!“ auf der Seite „Nach 
Aktualisierungen suchen“ erscheint, aktualisieren Sie bitte manuell 
auf die neueste Version. 

 Hinweis 

 

 Wenn eine ähnliche Oberfläche 
erscheint, klicken Sie bitte auf 
„Close“ (Schließen). 

 

 Wenn eine ähnliche Oberfläche 
erscheint, klicken Sie bitte auf 
„Install“ (Installieren). 

4) Exportieren und Analysieren von Daten 

1. Führen Sie den AI-EKG Analysesystem aus.  

2. Stecken Sie die SD-Karte in das Kartenlesegerät, und schließen Sie 
das Kartenlesegerät an den Computer an. 
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3. Wenn die Seriennummer des Geräts in der unteren linken Ecke der 
Software erscheint, ist die Verbindung erfolgreich. Klicken Sie auf 
den Knopf „Download Data“ (Daten herunterladen). Erstellen oder 
wählen Sie einen Benutzer. Die Daten werden dann automatisch in 
den Analysesystem importiert und in der Aufgabenliste angezeigt. 

 
4. Klicken Sie auf „View ECG“ (Anzeigen ECG), um die vollständige 

EKG-Wellenform anzuzeigen und herunterzuladen. 
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5. Klicken Sie auf „Analyze“ (Analysieren) und registrieren Sie sich. 

Diese Aufzeichnung wird auf den Server hochgeladen und ein 
EKG-Bericht wird erstellt.  

 Hinweis 

Wenn die Login-Oberfläche erscheint, klicken Sie bitte auf „Go to 
login“ (Zur Anmeldung gehen) und schließen Sie die Registrierung ab. 

Zur Anmeldung: 

 Holen Sie sich innerhalb von 15 Minuten den Verifizierungscode 
aus Ihrer E-Mail und schließen Sie die Registrierung ab. 

 Nach 15 Minuten müssen Sie den Verifizierungscode erneut 
anfordern. 

6. Nachdem die Analyse abgeschlossen ist, klicken Sie auf „View 
Report“ (Bericht anzeigen), um den EKG-Bericht anzuzeigen und 
herunterzuladen. 
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Italiano 

Guida all'uso del Registratore Holter e del 
Sistema di analisi AI-ECG 

1. Flusso operativo 
 

 

 
 
 
 
 
 
 
 

2. Istruzioni per l'uso 

1) Preparazione della registrazione ECG 

1. Installare batterie nuove e verificare che i poli positivo e negativo 
siano posizionati correttamente. Dopo aver installato correttamente 
la batteria, il registratore si avvia automaticamente e sullo schermo 
viene visualizzata l'interfaccia di avvio. 

 Attenzione 

 NON inserire una batteria con i poli positivo e negativo 
invertiti. 

 Se viene visualizzato il messaggio "Insufficient voltage!!! Do 
you want to continue?" (Tensione insufficiente!!! Continuare?), 
è possibile selezionare "Yes" (Sì) per continuare o sostituire le 
batterie con batterie nuove. Se si seleziona "Yes" (Sì), il 
Registratore Holter potrebbe non essere in grado di registrare i 

Preparazione della registrazione ECG 

Registrazione dell'ECG 

Installazione e aggiornamento del software 
 

Esportazione e analisi dei dati 



34 

dati per 24 ore. 
 Se viene visualizzato il messaggio "Please replace with new 

batteries!" (Sostituire le batterie!), rimuovere le viti dal 
coperchio del vano batterie e sostituire le batterie esauste 
con batterie alcaline AAA/1,5 V. 

2. Collegare il filo conduttore al registratore ECG. 

 Attenzione 

Se si prevede di utilizzare il dispositivo per lungo tempo, tenere il 
filo conduttore collegato al dispositivo e non collegare e scollegare 
il filo conduttore ripetutamente. 

3. Posizionamento degli elettrodi: 

 Fissare gli elettrodi monouso nel giunto dell'elettrodo del filo 
conduttore.  

 Rimuovere l'imballaggio protettivo sul retro degli elettrodi 
monouso.  

 Posizionare gli elettrodi in modo corretto seguendo 
l'illustrazione sul posizionamento degli elettrodi e assicurarsi che 
siano fissati saldamente alla cute del paziente. 

 
 

 

 

 

 

 

 
 

 

 

 

 

 

Quarto spazio intercostale 
(All'incirca allineato con il 

capezzolo) Quinto spazio 
intercostale 

Livello dell'ombelico  

Linea emiclaveare 
destra 

Linea emiclaveare 
sinistra 

Linea mediana sternale destra Linea mediana sternale 
sinistra 

Quarto spazio  
intercostale 

Quinto spazio 
intercostale 

Livello 
dell'ombelico  

Linea emiclaveare destra Linea emiclaveare sinistra 
 

Linea mediana 
sternale destra 

Linea mediana sternale  
sinistra 

Linea 
medioascellare 

Linea ascellare  
anteriore 
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 Colore 
AHA 

Colore 
Etichetta Posizione 

1 Rosso V1 Il quarto spazio intercostale sul margine destro dello sterno 

2 Giallo V2 Il quarto spazio intercostale sul margine sinistro dello 
sterno 

3 Verde V3 La posizione tra V2 e V4 

4 Blu V4 Linea emiclaveare sul quinto spazio intercostale 

5 Arancione V5 Linea ascellare anteriore, allo stesso livello di V4 

6 Viola V6 Linea medio-ascellare, allo stesso livello di V4 e V5 

7 Nero LA Spalla sinistra 

8 Rosso LL Il bordo inferiore della gabbia toracica, o il livello 
dell'ombelico nel punto della linea clavicolare media 

9 Verde RL Il bordo inferiore della gabbia toracica, o il livello 
dell'ombelico nel punto della linea clavicolare media 

10 Bianco RA Spalla destra 

2) Registrazione dell'ECG 

1. Premere il pulsante Invio per riattivare lo schermo. 

2. Selezionare "MENU” (MENU) -- "Date & Time” (Data e ora) e 
impostare il dispositivo sulla data e l'ora correnti. 

3. Selezionare "ESC” (ESC) per tornare all'interfaccia del menu. 
Selezionare "Options" (Opzioni) -- "Gain" (Guadagno) per impostare 
il guadagno di registrazione idoneo. 

4. Selezionare "ESC" (ESC) per tornare all'interfaccia del menu e 
selezionare "ECG review" (Revisione ECG). (Nota: il dispositivo non ha 
ancora avviato la registrazione dell'ECG). 

5. Premere il pulsante Invio per accedere all'interfaccia di registrazione. 
Selezionare "OK” (OK) per avviare il monitoraggio e la registrazione 
dell'ECG. 
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6. Confermare l'ID paziente. se necessario, modificare l'ID su questa 
interfaccia. 

7. Attendere che il sistema completi automaticamente la formattazione 
della scheda SD. Dopo la formattazione, il sistema accede 
automaticamente all'interfaccia di registrazione. 

8. Inserire il Registratore Holter nella relativa custodia in pelle e 
indossarlo con la cintura o la tracolla in dotazione. 

9. La registrazione si interrompe automaticamente dopo 24 ore. 

10. Al termine della registrazione, scollegare il registratore come segue: 
 Rimuovere la batteria esausta e smaltirla in modo appropriato 

in conformità alle leggi locali. 

 Premere la scheda SD che si aprirà automaticamente. Quindi, 
rimuovere la scheda SD estraendola con l'unghia dall'apposita 
scanalatura. 

 
 Rimuovere gli elettrodi dal paziente e scollegare i fili conduttori 

dagli elettrodi. 

 Nota 

 Trasferire i dati ECG salvati sulla scheda SD al Sistema di analisi 
AI-ECG poiché il Registratore Holter formatta automaticamente la 
scheda SD ogni volta che viene avviata una registrazione ECG. 

 Accertarsi che la scheda SD sia sbloccata. 
 Se non si preme alcun pulsante per 15 secondi nell'interfaccia della 

forma d'onda, il sistema passa automaticamente alla modalità di 
sospensione. Premere il pulsante Invio per visualizzare nuovamente 
la schermata del sistema. 
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Nome Pulsante Funzione 

Pulsante Su  

 Passa alla derivazione precedente. 
 Diminuisce il valore di 

impostazione. 
 Spostare il cursore verso 

l'alto/sinistra. 

Pulsante Giù  

 Passa alla derivazione successiva. 
 Aumenta il valore di impostazione. 
 Spostare il cursore verso il 

basso/destra. 

Pulsante Invio 
 

 Conferma il valore di impostazione. 
 Abilita la pagina "Recording 

Operation (Registrazione)". 
 Contrassegna gli eventi durante la 

registrazione. 

Pulsante Giù + 
pulsante Invio  +  

 Abilita la pagina "Exit Recording 
(Esci dalla registrazione)". 

3) Installazione e aggiornamento del software 

1. Scaricare il sistema di analisi AI-ECG con uno dei seguenti metodi. 
 Scaricare l'ultima versione del Sistema di analisi AI-ECG dal sito 

Web https://getwellue.com/pages/pc-software (per utenti 
Windows/Mac OS). 

 Scaricare il file di installazione dall'unità USB (solo per utenti 
Windows). 

2. Eseguire il file di installazione e selezionare le impostazioni 
predefinite fino al termine dell'installazione. 

3. Se è necessario aggiornare il Sistema di analisi AI-ECG, fare clic su 
"Settings" (Impostazioni) nell'angolo in alto a destra dell'interfaccia 
principale del sistema di analisi. Se appare il simbolo "!" sulla 
funzione "Check for Updates" (Controlla aggiornamenti), aggiornare 
manualmente alla versione più recente. 

 

 

https://getwellue.com/pages/pc-software
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 Nota 

 

 Se viene visualizzata 
un'interfaccia simile, fare clic su 
"Close" (Chiudi). 

 

 Se viene visualizzata 
un'interfaccia simile, fare clic su 
"Install" (Installa). 

4) Esportazione e analisi dei dati 

1. Eseguire il Sistema di analisi AI-ECG. 

2. Inserire la scheda SD nel lettore di schede e il lettore di schede nel 
computer. 

 
3. Se appare il numero di serie del dispositivo nell'angolo in basso a 

sinistra del software, la connessione è riuscita. Fare clic sul pulsante 
"Download Data" (Scarica i dati). Creare o selezionare un utente. I 
dati verranno importati automaticamente nel sistema di analisi e 
visualizzati nell'elenco delle attività. 
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4. Fare clic su "View ECG" (Vedi ECG) per visualizzare e scaricare la 
forma d'onda ECG completa.  
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5. Fare clic su "Analyze" (Analizza) e registrare. La registrazione verrà 
caricata sul server e verrà generato un rapporto ECG.  

 Nota 

Se viene visualizzata l'interfaccia di accesso, fare clic su "Go to login" 
(Vai all'accesso) e completare la registrazione. 

Per registrarsi: 
 Ottenere il codice di verifica inviato tramite e-mail entro 15 

minuti e completare la registrazione. 
 Dopo 15 minuti è necessario richiedere nuovamente il codice 

di verifica. 
6. Al termine dell'analisi, fare clic su "View Report" (Vedi report) per 

visualizzare e scaricare il rapporto ECG.  
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